Canon

Seiiiware Starter Guide

eee Canon Digital Camera Solution Disk eee

Install the bundled software programs,
and download images to the computer.

¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

¢ You may download images without installing this software.
However, there are several limitations (p. 77).
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and
correct use of the products and to prevent injuries to yourself or other persons, or
damage to property. Please read and ensure that you understand them before
proceeding to other sections of the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer hearing loss from listening with headphones to the
loud sounds of a CD-ROM played on a music CD player.

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the memory cards,
personal computers, peripheral devices, or use of non-Canon memory cards.

Canon Customer Support

For Canon Customer Support contacts, please see rear of the European Warranty System (EWS)
Booklet supplied with your camera.



Table of contents

Read This First 3
PreCaUTIONS ..cooi i 3
It's so Simple! Make Prints Right at Home Like a Pro ........c.ccc....... 4
Unbounded Possibilities with Entertaining Software .........cccoc...... 5
Enjoy Using CANON iMAGE GATEWAY

to Take Advantage of the Internet ..o, 7
System ReqQUIre€MENTS ......ooiiiiiiiiiiiiiee e 9
Using the Software on the Windows Platform

— Preparations 11
Installing the SOftware .......cccoeecee i 11
Using the Software on the Windows Platform

— The Basics 15
Downloading Images to the Computer .......cccccccveeiiciiieeeescneeenn. 15
Printing IMages .....ooo oo 20
Using the Software on the Windows Platform

— Advanced Techniques 22
The ZoomBrowser EX WIiNAOWS .......coooceireiiereiiee e 22
ZoomBrowser EX Features ... 28
Operating the Shutter Remotely (Remote Shooting) .................. 32
Merging Panoramic Images — PhotoStitch ........ccccoeriiiiiiiennnne. 35
Processing RAW IMages .......ccueeriireiiiie e 36
Enjoy Customizing Your Camera with the My Camera Settings ...39
Using the Software on the Macintosh Platform

- Preparations 43
Installing the SOftware .......cccoeeceeiece e 43
Using the Software on the Macintosh Platform

— The Basics 45
Downloading Images to the Computer .......cccccovveeiviiiieeeeicienenn. 45
Printing IMages .....coo oo 49



Using the Software on the Macintosh Platform

— Advanced Techniques 51
The ImageBrowser WindOWS .........ccccveiierierneinieesee e 51
ImageBrowser Features ... 57
Operating the Shutter Remotely (Remote Shooting) .................... 61
Merging Panoramic Images — PhotoStitch ........ccccoeniiiiiiinnnnenn. 64
Processing RAW IMages ......ccuevrirriiiiieesree e 65
Enjoy Customizing Your Camera with the My Camera Settings ...68
Appendices 7
Uninstalling the SOftware ..o 71
Memory Card Folder Structure ........cccccoceeiiiiieinie e 72
TroubleshOOtiNg ...cceiiiiiiieeie e 73
Downloading Images without Installing the Software ................. 77



This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

qSOIU!)DW/SMOPU!M

About this Guide

¢ The explanations in this guide are based on Windows XP and Mac OS X v10.4. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.

¢ The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.4-v10.5)

Precautions

Precautions for Connecting the Camera to the Computer

* The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.

¢ The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

¢ Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.

connecting to a computer. Ensure that you use fully charged batteries if you
cannot use an AC adapter.

¢ See the Camera User Guide for procedures connecting the camera to the
computer.

Iﬁl *You are recommended to use an AC adapter (sold separately) when
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It's so Simple! Make Prints Right at Home
Like a Pro

~— Shoot the images )

See your Camera User Guide for
shooting instructions.
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~— Install the software on the computer

Just install the software once at the
beginning.

~

Windows (p. 11)
Macintosh (p. 43)
G 4

v
~— Connect the camera to the computer

See your Camera User Guide for
connecting instructions.

~

Precautions for Connecting the
Camera to the Computer (p. 3) )

Windows (p. 15)
Macintosh (p. 45)
4

Windows (p. 20)
Macintosh (p. 49)
. y
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Unbounded Possibilities with Entertaining
Software

ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)

Versatile image management software for downloading images, editing still images and
movies, and printing.

Experiment with diverse printing techniques

Print a variety of layouts. Change paper sizes and print your photos with date stamps and
comments to enjoy an expanded range of possibilities.
Windows (p. 20)  Macintosh (p. 49)

Printing images is easy

= =

Print date e o | e )

oty -

222008 S e

e

S e o
B . e - . Print comments on your E E %EF!

postcards and invitations
Check multiple photos at
a glance with index
printing.

Edit a Movie

You can remove unwanted sections at the beginning or end of a movie. You can also use the
memory card reader to upload the edited movie to the camera.
Windows (p. 26)  Macintosh (p. 55)

Extract Stills from Movies

You can extract a still from the displayed movie and save it as a new image file.
Windows (p. 26) Macintosh (p. 55)
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Operate the Camera Shutter from the Computer (Remote Shooting)

Shoot and control the camera’s shutter from a computer. You can save the recorded images
directly to the computer. (Certain models only)
Windows (p. 32)  Macintosh (p. 61)
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Enjoy Customizing Your Camera (My Camera)

Set your favorite images and sounds as the camera’s start-up image or shutter sound. (Certain

models only)
Windows (p. 39) Macintosh (p. 68)

PhotoStitch (Windows/Macintosh)

A program for merging multiple images into dramatic panoramas.

Stitch a Panorama Together

o e

Windows (p. 35)  Macintosh (p. 64)
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Enjoy Using CANON iMAGE GATEWAY
to Take Advantage of the Internet

About CANON iMAGE GATEWAY

CANON iMAGE GATEWAY is an online photo service for the purchasers of this product.
Registering online allows you to use the various services. See the homepage for the latest menu
of services.

=
=
o
=
wv
S~
=
2
2,
=
=
o
w
3

http://www.cig.canon-europe.com

Upload andshare
your images

b

Your albums on CANON Your My Camera Settings Files

iMAGE GATEWAY on CANON iMAGE GATEWAY
B[S
Tell people about
your albums by email J
\{ =l
9

/\(Download My Camera Setting
‘/ Files (certain models only)

In addition, you
can get the latest
supportinformation <
simply by «
—  registering.

Family and friends
\_can browse easily )

~ /I

0 *See the homepage for information regarding browser versions (Microsoft
Internet Explorer, etc.) and settings to best connect to CANON iMAGE
GATEWAY online photo services.

e Internet access is required (you must already have an account with an
Internet service provider (ISP), browser software installed and an Internet
connection).

¢ Any ISP account charges and access fees must be paid separately.
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How to Register as a Member

You can register online using the supplied CD-ROM (Canon Digital Camera Solution Disk).

Supplied CD-ROM
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Connect to the
internet

Even if you have previously registered, registering additional information
about this product on CANON iMAGE GATEWAY allows you to access the
latest support information.

Use CANON iMAGE GATEWAY with the Supplied Software

You can upload images to online albums or download My Camera Settings Files (certain
models only) using the supplied software.

Windows (ZoomBrowser EX) Macintosh (ImageBrowser)
~ 02 PG IMG_0003 JPG IMG_0004 JPC
'ﬁ Print & Email = ¥+

o
f—l‘ CAMON iMAGE GATEWAY

3 ° &. &

eShow (CANON iMAGE Print & Email Send to Trash

Register/Add Product

Top Page Register for Image Gateway...

Image Gateway Top Page...

Wiess Onling Photo Alburm

Upload to Image Gateway...
Image Gateway Album...

Upload Imagss
< MG,

Download My Camera Contents...

——————

Dawnload My Camers Contents

To upload many images at once, use ZoomBrowser EX or ImageBrowser to
reduce the image size in a single batch for greater convenience.




System Requirements

Please install the software on a computer meeting the following minimum requirements.
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(O

Windows Vista (including Service Pack 1)

Windows XP Service Pack 2

Computer Model

The above OS should be pre-installed on computers with built-in USB

ports.
CPU Still Windows Vista: Pentium 1.3 GHz or higher
Images | Windows XP: Pentium 500 MHz or higher
Movies | Core 2 Duo 1.66 GHz or higher
RAM Still Windows Vista: 512 MB or more
Images | Windows XP: 256 MB or more
Movies | 1 GB or more
Interface USB

Free Hard Disk
Space

e Canon Utilities
- ZoomBrowser EX:
- PhotosStitch:
- Digital Photo Professional

200 MB or more

40 MB or more

200 MB or more
(certain models only)

Display

1,024 x 768 pixels/High Color (16 bit) or better

- Digital Photo Professional

(0} Mac OS X (v10.4-v10.5)
Computer Model The above OS should be pre-installed on computers with built-in USB
ports.

CPU Still PowerPC G4/G5 or Intel Processor
Images
Movies | Core Duo 1.66 GHz or higher

RAM Still Mac OS X v10.5: 512 MB or more
Images | Mac OS X v10.4: 256 MB or more
Movies | 1 GB or more

Interface USB

Free Hard Disk ¢ Canon Utilities

Space - ImageBrowser: 300 MB or more

- PhotoStitch: 50 MB or more

200 MB or more
(certain models only)

Display

1,024 x 768 pixels/32,000 Colors or better
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If you will be using Digital Photo Professional, check the “Processing Raw Images” section also
(Windows, p. 36; Macintosh, p. 65) (certain models only).

0 ¢ A CD-ROM drive is required to install the software.
¢ Even when system requirements are met, not all computer functions can be
guaranteed.
¢ A sound card is required to play movie file audio tracks in Windows.
¢ With Windows, Microsoft .NET Framework 2.0 or later is required.
¢ Macintosh software can only be used on disks formatted in the Mac OS
Extended (journaled) format.
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Previous ZoomBrowser EX/ImageBrowser Versions

eIf you are already using a prior version, use the supplied CD-ROM (Canon
Digital Camera Solution Disk) to install and overwrite it with the new
version.

e If you were using ZoomBrowser EX Ver. 2 or 3, perform the following
procedures after installing the software.

1. Double-click [dbconverter.exe] to start it.
Example: C:\Program Files\Canon\ZoomBrowser EX\Program Folder\dbconverter.exe

2. Select the database file used up to now and click the [Start] button.
Example: C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd

If images were saved in the Program Files folder, then continue with the

following procedure.

3. Copy the image folders in the Program Files folder to the [My Pictures]

folder.
Example: C:\Program Files\Canon\ZoomBrowser EX\Library (1)




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

e Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.
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3  Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the [User Account Control] window appears, follow the
on-screen instructions to proceed.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

1. Select [Computer] or [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

(i
3. Double-click the [SETUP.EXE]* b’) icon.
4. When [User Account Control] window displays, follow the on-screen instructions to
proceed.

* Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software [Easy
Installation] button. Canon DIGITAL CAMERA

To individually select the software to install, Solution Disk
click [Custom Installation]. S—
Custom Installation

Installer Panel

5 it other software is running, close each
program before clicking [OK].

Start installing Digital Carnera Solution Disk.
Close any other open applications and click [OK].
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6 Review the installation settings and

click [Install].

The items in the list may differ from those
illustrated depending on the software
installed on your computer.

Click [Yes] if you agree to all of the
terms of the software license
agreement.

The installation will start.

Follow the on-screen instructions to
proceed with the installation.

Click [Yes] if a dialog confirming the
installation of Microsoft .Net Framework
displays.

When the installation is over, select
[Restart computer immediately
(Recommended)] and click [Restart].

At this stage, do NOT remove the Solution
Disk from the CD-ROM drive yet.

.| Confirmation

Software to be installed

Total: 260 MB

swp2  Liense

swp3  Instalation

swpd  Fnish

F]
@ s e
@ cosu e

Vew 3 descrption of the software by passig your mouse over the nime of the. J
e

Installation folder Available space: 22447 MD

C\Program Fiss\Careri,

Click [Install] to start instaling.

< (" nstall ’,\,’

/| License

License Agreement:
He':;'s read the following License Agreement carefully before instaling the

INPORTANT NOTICE a

sp3  Instalstion

Sepd  Frish

Colrtah RGE, Wil Gar.t RG8),and whichar kensed under the mwnq 8
Adobe SYSTENS INCORPORATED COLOR PROFILE LICEVSE AGREEVENT. T

Carn oftware Licerse Agreeter;

SOFTWARE END USER LICENSE AGREENENT.

ATTETION: LEAERERD TS DOCLENTBFCRE NSTALING T
i

This s akense agresnentbetween you and Canen Inc., having s lace of

e 562 oo 3 chowe, Onr, Toky 146550, 100

(Carn’, it epectto o toare ncluding any nage data s sound data
oy (tre Do)

e . et oy B S,

B INSTALLING THE SOFTAARE YOU AGREE T0 BE BOUND BY THE TERIS OF
HIS AGREENENT. IF YOU DO NOT AGREE T0 THE TERMS OF THIS AGREEFENT,

PROVETLY CLOSE THIS INSTALLATION PROGRAN. I SLCH CASE,

SOFTWARE WILL NOT BE INSTALLED AND YOU WILL HAVE RO RIGHT TO LSET.

Gk [fes) to szt heLices Agresment. f you ek Nl the talaton

of Digtal Camera Salton Dk wil

7 N

(
LM )

Installation of the software has been completed.

Restart computer immedately (Recommended)

Finish

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive to conclude the installation.

13
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Q Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Iﬁl See Uninstalling the Software (p. 71) to delete the installed programs.

To ensure security on computers with Microsoft .NET Framework
installed, it will be necessary to update the computer using Windows
Update.

You may now download camera images to the computer (p. 15).




This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Windows Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 18).

Camera to Computer Connection

T After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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2 Select [Canon CameraWindow]
when a dialog (Events dialog)
similar to that on the right
displays and click [OK]. Lz Eaiizsiod
In Windows Vista, select [Downloads
Images From Canon Camera using 7
Canon CameraWindow] from the <? :
AutoPlay dialog. N

Canon SCOCOGOOOCO

Select the program ko launch for this action:

b Canon EOS Utility
é-l-“"' Downloads images from EOS camera
Your camera model name or —— | #
[Canon Camera] will appear here. 72 Microsoft Scanner and Camera ‘Wizard
Download pictures from & camera or scanner

Different programs may display
depending on your computer setup.

[ Alweaps use this program for this action

If this Events dialog does not appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[CameraWindow] and [CameraWindow].

CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

CameraWindow

6/12/2008

CameraWindow DC

T
&
m { .‘ Operate using the camera

Push the camera buttons

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window

3 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] or [My Pictures] folder.



Using the Software on the Windows Platform - The Basics | 17

Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

*When it is possible to use the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Dyan
(Print/Share) button will light blue.

*See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Chaz (Print/Share) Ve ~N
button or the FUNC./SET button.

Direct Transfer

The yan (Print/Share) button will blink AL s

blue during the transfer and remain lit [l DPORRIFane W liAgesy
when it is complete. Click the mouse = Select & Transfer..
button or press any key on the keyboard to & Wallpaper..
resume the ability to operate from the

computer.

Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow

6/12/2008

CaNON U

CameraWindow DC

{ E.\—] Operate using the camera
‘ Push the camera buttons.

Transfer Untransferred Images

Click this buttonto —0——m—-——uo-—— Operate Images on Camera
close the start screen.

Thumbnail Window View Window

*To download images that have had transfer settings set with the
camera, use the camera or a memory card reader.

¢ To check images in the camera or to download only a portion of the
images, click [Operate Images on Cameral.

1]
*You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.




When you click [OK] in the image transfer completion window, the transferred images will

display in the Main Window.

Using the Software on the Windows Platform — The Basics

The downloaded images are saved into folders according to the shooting date.

The last downloaded images
will display here according
to both their shooting dates
and categories.

IMG_0001.PG

Folders Area
The downloaded symbol
displays on downloaded
folders.

IMG_0005. PG

IMG_O005. PG IMG_0007. PG

Selcted ams: 0

Thumbnail

Next, print out the images (p. 20).

Memory Card Reader Connection

T insertthe memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2 sclect [View/Download Images using
Canon ZoomBrowser EX] when the
dialog to the right appears and click

[OK].

[ Ahways do the selected act
[ Ok ] ) Cancel
i -

proceed to Step 3.

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [ZoomBrowser EX
Memory Card Utility], [ZoomBrowser EX Memory Card Utility], and

18
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3 Click [Download Images].

ZoomBrowser EX Canon

 een
(' Download Images |)

|

You can adjust the settings, such as
the type of image downloaded and

the destination folder, by clicking

[Preferences]. = _

Lets you select and
download images

Preferences... Exit

¢ By default, all the images that have yet to be downloaded wiill
download to the [Pictures] or [My Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

¢ Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

*See Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date and category in the [Last Acquired
Images] section.

Next, print out the images (p. 20).

19
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Printing Images

There are three methods for using ZoomBrowser EX to print images: [Photo Print], [Index Print]
and [Print Using Other Software]. This section explains how to use the [Photo Print] option.

* Movies cannot be printed, but you can print still images saved from movies.
¢ To use the Index Print option, click [Print & Email] in the Main Window,
followed by [Index Print].

Prints one image on each page.

1 cick [Print & Email] in ZoomBrowser EX's Main Window, followed by [Photo

&7 ZoomBrowser EX. 7 ZoomBrowser EX - All Images.
File Edt View Tools Int File Edt view Tools Internet Help
Tasks Tasks (2]
(18] Acquie & Camera Settings P
AmoREm=n iy Zoom Mods | Scrol Made | P (3] acquite 1. Camera Setings Zoom Made | ScralMads | Pr
Sinoges
(I} vewscmssy o [ vewicosis Allmages
= ca
&l Pt
[
= e
= 7] Shooting Date:
%] 2008_06_12 o
. % 2008_06_13 IMG_0001.JF Pint Using Other Software. IMG_0001.3P
= Email Images. ¥ >
@ Fuents d -— - '

2 After confirming that [1. Select Images] is selected, select images.

You can select multiple images by holding the [Ctrl] key down while clicking on successive
images.

7 ZoomBrowser BX. - Allimages.

The background of
selected images
changes to blue.

Use this task a printthe selected
photos. each one on a separ
pege

ETTrT—

IMG_0004. PG

IMGO005. PG IMGO0O6. PG IMG_0007.PG

Selcted ims: 3
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3 cdlick [2. Printer and Layout Settings] and adjust the categories as you feel
necessary.

Text can be inserted here to print
with this photo.

Photo Satings and Preview

Remove unwarted
ragions of your phata.

‘ Add orModiy exito
TimImage nserText

printwih iz phato.

Paper Size:
[atin 101652 amm

Selects the printer
and the paper size
etc.

ordeless

Selects a printing
method for the
shooting date/time
information.

Totel: 3 pages

Selected tens: 3

Sets the number
-l— of print copies.

This button switches between images if
multiple images were selected.

4  Click [3. Print].
Printing will start.

This chapter explained the ZoomBrowser EX basics.
Once you have mastered them, try the advanced techniques.

e Using the Software on the Windows Platform — Advanced Techniques (p. 22).



This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer

Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Buttons (p. 23)

7. ZoomBrowser EX. - CAD icuments and Settingsboodhy Documents\y Pictures\2008_06_12

Function Buttons (p. 25)

Zoom HMode | Sciglibode | Preview Mode )

Display Mode

2008_06_12 QOO0 R-0-/[2]Q L

[t | §F e - (p 24)

(3) 2008_06_12
) 2008 0613
s 5

IMG_0001.7PG

IMG_0005. PG IMG_0006. PG IMG_0007. PG

Display Control
Panel (p. 25)

Browser Area
(p- 23)

Selected Items: 0

Switches between

Folders Area (p. 23)

Last Acquired Images (p. 23)

showing and
hiding the Task
Buttons and Last
Acquired Images
section and the
Folders Area.
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Task Buttons

e ZoomBrowser EX's tasks are arranged here like an index.
e Click a Task button to carry out the desired task.
These features are described in ZoomBrowser EX Features (p. 28)

Folders Area

¢ Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

* If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

o If [Favorite Folders] is displayed: click [Add] and select a folder.

o If [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Last Acquired Images
¢ You can check images grouped according to the shooting date or My Category.

Browser Area

¢ The folders and the images within the folders selected in the Last Acquired Images section or
Folders Area display here. The display style will vary according to your Display Mode selection.

*You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by selecting [View] and [Sort by].

* The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode

m RAW images

E Movies

Images with sound memo attachments

E Protected images

Images shot with the camera's AEB function
Rotated Images (In display only)

23
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Display Mode

o Selects the display style for the Browser Area.

Zoom Mode

Displays all the images in a folder as thumbnail
images. This mode is convenient for searching
for images since many can be displayed at
once.

T versoom

BT

ARG e

B o

If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.

If you move the mouse cursor over a folder,
=] will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

The images within the selected folder and
subfolders will display. If you set the display
folder depth (level) to [1] or greater, the
thumbnails of the images in the folder will also
display. You can change the folder depth in the
[Tools] menu under the [Preferences] option.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

b SIS [P
o) e e

MGOTLFS  MGOVRRS  MOIURFG  MGOAFS MG ONSFS

@ - (Show Information) menu.

thumbnail causes the image to appear at a higher magnification in a Mouse

lﬁl In zoom mode or scroll mode, positioning the mouse pointer over a
Over window. You can also set the Mouse Over window to not show in the

24
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Selection Menu Fit to Window Display Size
Click this to select/deselect all ~ Changesthe thumbnailsizeto Changes the size of the
images in the Browser Area. fit them into the window. thumbnail in the Browser Area.

]

QOO0 R-0-||h& O e | §FFiter -

Show/Hide Image Information Menu Filter Tool Menu J

Select here to show/hide such image Displays only images that
information as the file name or correspond to the specific
shooting date or rating beneath the conditions.

thumbnail.

Select Button
Use this to select images
in Zoom mode.

Function Buttons
¢ These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
or movie in the Viewer selected images. image.

Window. | |

= e [ - A
i | View Image Properties "#J Slide Show { Search ".j Delete E}' Rotate
7 b I

\_‘

Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteria as the images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu
You can edit, eliminating red eyes,
adjusting colors and brightness,
cropping and inputting titles. You can

also use it to start up other programs Shooting .

for editing. P prog Information Synchronize Button
Display Button Synchronlzgs the

Print Button Displays image dISF|>|_ay| settings when

Prints the displayed image. shooting g};‘ Tlap :dlmages are
information. played.

[ ZoomBrowser, EX - G:\Docume ts and SettingsbooaMy, JocumentsUy Picturesi2008.06_10UMG 000 .0p6 [= |[E][X]

—
Image Selector Nymber of
Button Displays
Switches between Button
images. Dlsplgys
multiple
Sets the image  — images at
display size to the once. This is
size in the Viewer handy f_or
Window. comparing
images.

Displays images in —

the Viewer
Window at their
actual size.
I
Zoom Star Rating
Changes the image Sets the Star Rating for an image.

zoom setting.
Full Screen Button
Displays the image in the full screen mode. Click the image or
press any key on the keyboard to restore the normal display mode.

*RAW Image is Displayed
The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed
eButtons will appear beneath the movie, allowing it to be played or the
sound to be adjusted.
*On some computer systems, you may experience dropped frames leading to
jerky motion or intermittent sound when replaying movies.
*You can extract still images from movies by clicking the [Save as still image] button,
which appears beside the Star Ratings buttons. You can also delete unwanted
sections at the beginning or end of movies by clicking the [Cut Movie] button.
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categories. 5
5 Modified. 6/12/2008
File Size: 470.6 KB
Image Size: 1600 % 1200
Diata Type: JPG
Sound ———1— Plays a sound memo attached
to an image.
Path: CADocuments and SettingsisxxiMy Docume
o Protect
. IZI i Prevents an image from being
File Name {IMG_D01 |

overwritten or deleted.

The file name
can be changed.

A

Star Rating and My Categony: ]

Star Rating and Comment

My Category in Kamakura Comment

?g:sa;h?n',’aag:g You can type a comment here.
. o Keprords:

ooy 1Fa My (e Keywords

Sets the keywords used in

i Brightness Histogran:
Category is set. searches.

Brightness Histogram
A graph of the highlights and
shadows distribution in an

:

Shooting Information:

image.
Iterm Mame: Walue A 9
. . File Mame IMG_0001 JPG
ShOOtlng Informat|on Camera Model Mame  Canon 3000{ b
H H Shooting Date/Time  5/12/2008 9:15:22 AM

_Dlsplays C.jetalled Shooating Mode Auta
information, such as the Tu (Shutter Speed] 14250
Shutter Speed and A_v [Aperture Walue] Al P

. ik einnFesmuinenten )
exposure compensation — Image Selector Buttons
setting. The camera model If multiple images are selected
yV|II dete.rmlr'ne vyhat with the Properties Window
information is displayed. displayed, you can switch

between the images for which
the information is displayed.
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ZoomBrowser EX Features

This section briefly introduces the ZoomBrowser EX features.

models. Check the Specifications section of your Camera User Guide to see if

Iﬁl Some ZoomBrowser EX functions may not be available with certain camera
your model supports them.

The following workflow is used in ZoomBrowser EX.

ll Click a Task button.

Check the Help menu for
procedures and features.

7. ZoomBrowser EX - Al _geo.

Fie Edt Vew Toos Inter

A o [Gal siestow [ searcn
(8] Acquie & Camera Settings ode | SctollMode | Preview Mode]
T vevtcos o ER RIEE J— &= -
L e
Task Buttons —(5 .
gj Pint & Email

Photo Print

Indet Print

Pt Using Other Software.
- I
e

The Task buttons are explained in “Task Button Functions” (p. 29).

2 rerform the procedures according to the instructions.

Summary of the
procedures for this step

BEE

Steps to follow

Procedural instructions

Return to Main Menu

28
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Task Button Functions

Acquire & Camera Settings

Connect to Camera
You can do the following when you connect
the camera and display CameraWindow.

‘ @ Acquire & Camera Settings ‘

G Acquire Images
I=Y Downloads images and sound files from the camera (p. 15).

Print Images

=3 Selects and prints the images in the camera.

G} Write to Camera

Uploads images on the computer to the camera.

) Set to Camera
3@ Sets the camera owner’s name.

Connect to EOS Camera
This can only be used with EOS series cameras. For details on this function, see the user guide
for your camera. (Windows XP only)

Acquire Images from Memory Card
Downloads images and sound files from a memory card (p. 18).
You can also select images on the memory card and print them.

Transfer Images to Memory Card
Uploads images from the computer to a memory card.

View & CIUSS“:V ]jlli Wiew & Clazsify

View as a Slide Show

Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files

Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder.
Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.
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Edit
. = ‘ Edit

Edit Image

Allows you to perform image editing, such as

cropping, image correction, inserting comments, and red-eye correction. You can also use it
to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 35).

Digital Photo Professional - Process RAW Images (certain models only)
Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 36).

Export

Export Still Images =/ Export
Allows you to change the image size or type,
and export it as a new image.

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.

¢ CD-R/RW capable drive supplied as standard equipment

¢ CD-R/RW writing capabilities are operating correctly
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Print & Email = ‘

= . N
Photo Print """'«...—-fj P 5 i)
Prints one image per page (p. 20).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Email Images

Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

ZoomBrowser EX has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 39).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 32).
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

0 e Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 ik [Cancel] (&34 in Windows Vista) to close the Events Dialog (or the slide
show screen) if it appears.

If CameraWindow appears, click [Operate Images on Camera] followed by E3 in the View
Window to close CameraWindow.

CameraWindow

6/12/2008

q,:

CANON UTILITIES

CameraWindow DC

@ Operate using the camera
‘ Push the camera buttons

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window



uh
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In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [RemoteCapture DC 3] and [RemoteCapture DC].

According to the default settings, recorded images are saved into the
[Pictures] or [My Pictures] folder. To change the destination, open the
[File] menu in the remote shooting window and select [Preferences].

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard'’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera

is used independently.

3




Shows/Hides the

viewfinder or detailed

settings area.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera'’s viewfinder.

Using the Software on the Windows Platform — Advanced Techniques

Size and Resolution Selector

Selects the size and resolution at which images are captured.

bl RemoteCaptureTask
File(F) Camera(C) ShootingiS) Help(H)

@ Hide YiewFinder
@ Hide shooting details

= Add comments shown below

Field angleiflash Shooting settings

Flash:

| | ot El
Macro;

Jort [ =]
AF-gzsist light:

on -

AF operation:

AF unlock hd

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

Set the basic camera settings here.

Iﬁl The settings available vary between camera models.

34
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 dik [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].
2 Click [1. Select Images] and select several images in the Browser Area.
3 Click [2. Open PhotoStitch]. Epmmasien e

Fe Edt Vew Merge Hep

-"7. Vi Merge Images Shot in Stitch Assist Mode
N
- el

Cick (2. Megelto mero

Instructions

STA_0578.PG | STBOS79.PG | STC_0580.JPG | STD_0581.0G

o of rages: 3 Y

) Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

* Some camera models may not support Stitch Assist mode.

¢ See the Camera User Guide for information about shooting in Stitch Assist mode.

eImages shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

*Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

*The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

*You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 dik [Edit] in ZoomBrowser EX's Main Window, followed by [Digital Photo
Professional Process RAW Images].

2 select aRAW image in Digital Photo Professional’s Main Window.

3 =i} (Edit image window).

Main Window

Selects folders ——
containing
images.
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) Adjust the image brightness and white balance in the tool palette.

The modified contents (the information for image processing requirements) are saved
along with the image as a “recipe”.
The items available to be modified differ depending on the camera model.

You can adjust all three RGB

channel levels together or

separately with the Tone Curve. Reduces noise that occurs
when shooting night time
scenery, or when shooting
at a high ISO speed.

ictures\MG_0012.CR2)

RAW | R68 | NRLe

farine

Adjusts the brightness,
white balance and picture
style.

Shnotsatings

[Frmeave

Adjusts the contrast, color
tone, colorsaturation and
sharpness.

Tool Palette

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 In the [File] menu, select [Convert and save], set the file type and destination and
then click [Savel].

Conyert and save PX
Selects the file — ¥ 08
destination.
e
My Dot
Renames the file. 9
Ii
Quality setting
. Image quality 210
Selects the file type. cuputssting
Output resolution ol [ Embed ICC profile in image
T ¢ Insert a check
L « [ mark here to
change the file
size.
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

Inserts text.
E:\Documents and Settings\oo\My Documents\My Pictures\IMG_0012.CR2
-

Text | Seting:

XXXXXXXXXXXXXX

xxxxxxxxxxxxx

Sets the image size and
image layout, and
shooting information.

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

I_# Inserts text.

printer | Image | Toxt
Layout
Number of mages
Colurmns

ERE)

Sets the number and order
oo of images laid out on one
Lot sheet.

O Vertical

Rows:

® Horizontal
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Enjoy Customizing Your Camera with the My
Camera Settings

My Camera functions are only available with camera models listed as
compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you

install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 click [Cancel] ([E=34 in Windows Vista) to close the Events Dialog if it appears.
If CameraWindow appears, click [Operate Images on Camera] followed by E3 in the View
Window to close CameraWindow.

CameraWindow

Operate using the camera

Push the camera buttons.

|-
B
J
¥

g 3 e ;
Operate Images on Camera
o =

Thumbnail Window View Window
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3 Inthe [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.

4 cick [Connect to cameral. E‘ST%&
The My Camera window showing HORSERALZ!
images in the camera will display. KABUKIYD21 .

Corinect to camera |

Close
5 Select the [Setup as a theme] tab.
To set the start-up image or sound individually, select the [Set individually] tab.
6 sclect the settings to add and replace.
Settings to add: select from the [My Computer] list.
Settings to replace: Select from the [Camera] list.
7 cik [Save to Camera]
Clicking [OK] overwrites the settings previously registered on the camera.
My Camera X
lssx:x-Tuy:wEmage—;l
ﬁ " Play Delete:
Displays the oot Cavon -
settings saved to - b ' 4
the computer. H Heo
i [Save to PC] Button
Saves settings files
[Delete] Button e oo registered with the
Deletes settings e camera to the
from the computer. computer.

8 Changing the My Camera settings with the camera.
See the Camera User Guide.
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Creating Original Start-Up Images or Sounds

You can use My Camera Maker to effortlessly create image files or sound files for use as start-
up images or start-up sounds.

T Inthe [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.
The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.

My Camera Maker will start.

Ed]

My Camera

Setup as atherf  Setindvidualy |

Select My Camers Datatype and set individually.

Data Type:

Start-up Image(for commaon cameras) ;l

My Computer:

1.JPG L) Startup Sound
ANIMALOZ22_SIMLIPG Shutter Sound
ANIMALO23_SI0 JPG

BAR21_SIDTJPG Operation Sound

BASEBALL21_SI01.JPG
CHIMPANZ1_SI01.JPG
ETHD&NCEZ1_SI01.JPG
ETHTECHMZ1_SI01.IPG
FUN21_SI0N.JPG
FUNZ2_SI01.IPG
FUN23_SI01.JPG
FUN24_SI01.JFG
GAKKIZI_SI0TJPG

H GAME21_SI01JPG —
Add File Button GAME2Z 5I01JPG _—
H H GAME23_SI01.JPG
Adds images angi sounc_i files for use B e Fan
as settings files in the list. HORSERAC21_SIDN.JPG
|

Selftimer Sound

IY&SHI21_SI0LJPG
KABUKIVO21_SI01.JFG

KIKORIZ1 5101.JPG )

Add File. Create My Camera data

Flay Delete Connect to camera |

Close

3 Follow the instructions at the top part of the My Camera Maker window and
create image or sound files.
The created settings files automatically appear in the My Camera window.
Add the files to the camera following the procedures in Adding My Camera Settings to
the Camera (p. 39).
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Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images

Image Type : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Resolution (WxH) :320 x 240 or 512 x 288*

* Varies with camera model

e Start-Up Sounds
Type : WAV (Monaural)
Bit Rate / Frequency : 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the
following chart.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.
Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

&u) in the CD-ROM window.

4 Click the Digital Camera Software [Install] button.

Canon DIGITAL CAMERA

Installer Panel
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5 Select [Easy Installation] and click
[Next].
Select [Custom Installation] to select
programs individually for installation.

6 cik [Agree] if you agree to all of the B g e o B A e Y
terms of the software license &t Y e s St o T

s
Soare.Cuse il mean o, osin, s, xeeuing or dspining he soruird on you ok

a reem e nt computers, such as workstations, mmmals or other devices for your own personal use; (2) use the Data that is
. stuced o be used3s nstaled ito 3 Canor' gl sl or video camera produc i theuse dogigy ”

7  Review the installation settings and
click [Next].

Follow the on-screen instructions to St o

‘Macintosh HD:Applications Canon Uities

proceed with the installation. e

8 \When the installation is over, click
[Finish].

Installed
Installed
Installed

9 cliick [Exit] in the installer panel and remove the disk
from the CD-ROM drive.

This concludes the software installation.

See Uninstalling the Software (p. 71) to delete the software installed
with these procedures.

Continue by downloading images to the computer (p. 45).



This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).

Camera to Computer Connection

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

CameraWindow

SET  SET

CANON U

CameraWindow DC

Operate using the camera:

@

Push the camera buttons

e Transfer Untransferred Images

Q
L Operate Images on Camera

Thumbnail Window View Window

If CameraWindow does not open, click the [CameraWindow] icon in the
Dock (the bar at the bottom of the desktop).

2 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] folder.

Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

¢ If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Dyar
(Print/Share) button will light blue.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Chan (Print/Share)
button or the FUNC./SET button.

Direct Transfer

The Lhyar (Print/Share) button will blink Wl LEri
blue during the transfer and remain lit DPOF Trans. Images.
when it is complete. Click the mouse [ Select & Transfer..
button or press any key on the keyboard to EJ Wallpaper..

resume the ability to operate from the
computer.
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Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow - ] Canon Utiites CameraWindow DC - IMG_0007
) e
B %
Ed N

CaNON UmiLiTies

CameraWindow DC

Operate using the camera:
but

Click this button to
close the start screen.

Thumbnail Window View Window

*To download images that have had transfer settings set with the
camera, use the camera or a memory card reader (p. 48).

¢ To check images in the camera or to download only a portion of the
images, click [Operate Images on Camera].

=
*You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.

When you click [OK] in the image transfer completion window, the transferred images will
display in the Main Window.

The downloaded images are saved into folders according to the shooting date.

The last downloaded images
will display here according
to both their shooting dates
and categories.

Folders Area
The downloaded symbol
displays on downloaded
folders.

Thumbnail

Next, print out the images (p. 49).
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Memory Card Reader Connection

T  insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the
reader.

2 ik [Download Images].

ImageBrowser Camen

‘ Download Images ’

. . S
You can adjust the settings, such

as the type of image downloaded R Tt
and the destination folder, by

clicking [Preferences]. =

| Preferences... Exit

If the window above does not open, click the [CameraWindow] icon in the Dock (the bar
at the bottom of the desktop).

Iﬁl ¢ By the default settings, all images are downloaded to the [Pictures]
folder.
¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.
¢ Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.
eSee Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date or My Category in the [Last
Acquired Images] section.

Next, print out the images (p. 49).
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Printing Images

There are three methods for using ImageBrowser to print images: [Photo Print], [Index Print]
and [Layout Print]. This section explains how to use the [Photo Print] option.

Iﬁl Movies cannot be printed, but you can print still images saved from movies.

Prints one image on each page.

1 select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [§8 ] (command) key while clicking on images.

(Fvormerolgers Al Folders )

»
(32008 06.05
£42005.06.10
32008 0611
[#2008 0612
[32008.0613
»{ ¥ iPhoto Library

-  —— Ablue frame

(T — di5p|ays around
R B8 .
| ALl \ selected images.

CoonComers Vewlmage  Sidsshow pra e SendtoTrssh

2 Click [Print & Email] and select [Photo

Print]. 2 _ 2

show % tmail

Send to Tras]

kil Total: 5 images

Photo Print...
e Prin

. Layout Print... |
| Create Image for Email... |

Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.

Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.




Using the Software on the Macintosh Platform — The Basics

3 setthe categories as you feel necessary.

8066 Photo Print

Printer

Selects a printer.

Selects options such as the paper size _I_
and orientation when you click
[Page Setup].

Paper size
A4
Click [Page Setup] to enable

borderless printing on
supported printers.

Shooting Date/Time

Selects a printing method for the
shooting date/time information.

None ]

| [ g1 | Remove unwanted regions of
= | your photo.

|85 ] e ooy e e
his photo

Copies: 1)@

Total:  3pages

< E e 148
1

= Cm o

Click [Print].
The Print window will now open.

After the printing finishes, click [Close

This chapter explained the ImageBrowser basic

Sets the
number of
copies printed.

Click this button to switch
between images if you
selected multiple images.

Text can be inserted here to —
print with this photo.

After setting the number of copies, and other settings, click [Print].

] to close the window.

S.

Once you have mastered them, try the advanced techniques.

* Using the Software on the Macintosh Platform — Advanced Techniques (p. 51).
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This chapter explains various ImageBrowser features.

Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

Browser Window

This window is for displaying and organizing images downloaded to the computer.

Last Acquired Display Mode Browser Area
Images (p. 52) (p. 53) (p. 52)

806

Last Acquired Images
v&ishow All Images
il shooting Date
[]2008_06_12
[2008_06_13
@My Category

Wyreople
i Scenery

events
et o)
5 Movies

Vi@ Pictures
»{72008_06_08

Sound )

(720080609
[72008_06_10
720080611 ) o
[#2008_06_12 ¥ | ¥ Commen
[82008.06.13
> iPhoto Library

1MG_0002.°C IMG_0003 PG IMG_0004 PG

= Q Q[ s |
( ) = E] B, ®

|

No.of mafs Selectad: 1 ot 7 mages

Folders Area (p. 52) Control Panel (p. 54) Display Control Panel (p. 54)
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Folders Area

¢ Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.

¢ If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o I[f [Favorite Folders] is displayed: click [Add] and select a folder.
o If [All Folders] is displayed: select a folder and click [Add to Favorites].

Last Acquired Images
*You can check images grouped according to the shooting date or My Category.

Browser Area

¢ The folders and the images within the folders selected in the Last Acquired Images section or
Folders Area display here.
The display style will vary according to your Display Mode selection.

¢ The following types of icon will display around images according to their attributes.

Cha Images shot with the camera's Stitch Assist mode
RAW images

‘- Movies

F.Iﬂ Images with sound memo attachments

[ Protected images

C Images shot with the camera's AEB function

@  Rotated Images (In display only)
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Display Mode

o Selects the display style for the Browser Area.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

MG 0001
20081211
2@

=g B R
List Mode T

Displays the images in the folder selected in
the Explorer Panel section in rows and
columns.

G_0001pG G 00028 MG 0003 G 00046

MG_0005.G MG 0006 66, 600076,

=3 & ]

Canon Camera— View Image Sideshow P8 Emall  Send o Trash
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu
Changes the size of the thumbnailin  Click this to select/deselect all
the Browser Area. images in the Browser Area.

|

View ‘:v:" Filter Tool ‘.H G IVI e Q q || SEIE“i"g.lmages YH(E E ﬂ)

Filter Tool Menu Hide Buttons —————
Displays only images that correspond to the Left: Hidesthe Explorer Paneland
specific conditions. the last downloaded image.

Middle: Hides the control panel.

Right: Hides the Show Shooting
Information panel in the
Preview display mode.

Control Panel
* The control panel contains buttons for executing various functions.

i =4 = k|

Canon Camera View Image SlideShow Print & Email Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 58).
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Double-click an image in the Browser Area to display it in the Viewer Window.

606 & IMG_0001JPG (1/7)

Zoom
Changes the
image zoom
setting.

Star Rating Menu

B, e Sets the Star Rating

Back Next

WWWWWW I . foranimage.
Image Selector Button
Switches between
images. Show Information Menu
Displays shooting information.
Save Button !
Saves the edited image. Print Button
Prints the displayed image.
$d't Menud_t T——— r Full Screen Button
Ou can edit, eliminating red eyes, Displays the image in the full screen
adju§t|ng c_olors_ and brightness, cropping mode. (You can also double-click an
?(nd |nput'f|ng t'tlis;c tart h image to display it in full screen mode).
ou can afso usde_tl_ O start up other Click the image or press any key on the
programs for editing. keyboard to restore the normal display
mode.

Number of Displays Menu
Displays multiple images at
once. This is handy for
comparing images.

Synchronize Button
Synchronizes the display settings when multiple
images are displayed.

*RAW Image is Displayed
The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed
eButtons will appear below the movie, allowing it to be played back or the
sound to be adjusted.
*On some computer systems, you may experience dropped frames leading to
jerky motion or intermittent sound when replaying movies.
eIf you click the [Save as Still Image] button, you can extract still images from
movies. You can also delete unwanted sections at the beginning or end of
movies by clicking the [Cut Movie] button.
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File Information Window

The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview
display mode.

Star Rating / My Category
Switches between showing and hiding Sets the rating for an

detailed information for the category. image.
Anicon will display if a My
Category is set.

File Information

Star Rating
Switches between (B :
showing and
hiding detailed ¥ Comment
information. nramar Comment
You can type a comment
Flewame  [Mc0001 4| here.
Plays a sound —— - 2008/06/12 18:22:41 ¥ Keyword
memo attached File Size: 528 KB (537,343 Bytes) Keyword
. Image Size: 1600 x 1200 — .
to an image. —r g Sets the keywords used in
Sound: searches.
Lock: ?
Lock - Brightness Histogram
Prevents an image v " A graph of the highlights
from being T and shadows distribution
overwritten or S it P f
i in an image.
deleted. e e [
Soosing o e ‘”‘-H— ——— Shooting Information
Mikperre 71 Displays detailed
o information, such as the
mage Qo Fine v shutter Speed and
) Qo) > exposure compensation
setting. The camera model
. will determine what
Image Selector Buttons File Name information is displayed
When multiple images are You can change
selected, you can switch file names.

between images that display
information in the File
Information Window.
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ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

Some ImageBrowser functions may not be available with certain camera
models. Check the Specifications section of your Camera User Guide to see if
your model supports them.

The following workflow is used in ImageBrowser.

T select a feature from the Control Panel or the menu.

,(.V,..V,g.m,w,s.m e —— L— Check the Help menu for

T o o procedures and features.
Menu — =
New Folder ®N

Favorite Folders > v sar Rating

e :
Get Info ® (Ca—
Copy Image... - g

Move Image...

Duplicate #D

Rename... A

send to Trash ®a e

search... 3F Ll

Export Image... ~ —

Organize Image >

Process RAW Images by Digital Photo Professional. G 0004 9 G 0003 76 00029 WG 0001 76
€ — R

Connect to Camera... =TAT
View [ G s o O A Q[ e &

Rewrite Image to Memory Card... 2 | S A BEEE]

Print >~ Photo Print... 3P ) = )]

Canon Camera Viewlmage  Sideshow P& Emal  Send to Trash

W Index Print... P—- — |

Sound

Layout Print...
Create Image for Email... |

\ S—— J
I

Control Panel

2 perform the procedures according to the instructions.

606 Photo Print
Printer
XXXXXXXX S}

Paper size
A4

Click [Page Setup] to enable
borderless printing on
supported printers.

Shooting Date/Time

None =

Properties

Procedural instructions Remor e grcof. |

your photo.

Add or Modify text to print with
this photo.

=
AN o 45 o BT e S0
g
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i & = 3

Canon Camera View Image SlideShow Print & Email Send to Trash

Canon Camera

CameraWindow will display if the camera is connected, and you will be able to perform the
following actions.

Acquire Images
Downloads images and sound files from the camera (p. 45) .

Print

Selects and prints the images in a camera.
Write to Camera

Uploads images on the computer to the camera.

Set to Camera
Sets the camera owner’'s name.

(8 [E@’ [W ﬂ:u@’

v
-

E

You can perform the following actions if a memory card reader is connected.

eDownload images from the memory card
Download image or sound files from the memory card (p. 48).
You can also specify images on the memory card for printing.

eUpload images to the memory card
Upload images from the computer to the memory card.

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.
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Print & Email

Photo Print
Prints one image per page (p. 49).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Create Image for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]
*Edit and Save: allows you to change the file type or size and export the file.
eExport Shooting Properties: allows you to export the shooting properties as a text file.
eExport as a Screensaver: Exports the image as a screen saver file.
eExport an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.

*Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [Process RAW Images by Digital Photo
Professional] (certain models only)

Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 65).

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 64).
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Display Settings: [View] menu, [View Settings]
Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]
Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.

ImageBrowser has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 68).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 61).
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

0 ¢ Ensure that you turn off your computer’s sleep mode before you begin

remote shooting. The device performance cannot be guaranteed if the
computer enters the sleep mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 if CameraWindow appears, click [Operate Images on Camera] followed by in the
View Window to close CameraWindow.

CameraWindow 2 . Jooo i D CAINGO002

CameraWindow DC

L Operate using the camera:
LOQ  puch the camera buttons

Thumbnail Window View Window
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Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [RemoteCapture DC] icon.

According to the default settings, recorded images are saved into the
[Pictures] folder. To change the destination, select [Preferences] from the
[RemoteCapture DC] menu.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

Click the [Release] button.

or the keyboard’s space key.

¢ Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.

@ *You can also release the shutter by pressing the camera’s shutter button
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Size and Resolution Selector
Selects the size and resolution at which
images are captured.

Shows/Hides the
viewfinder or
detailed settings

area. . .
Rotation Settings

Sets the rotation
parameters for
images after they are

8eoo
(5 Hide ViewFinder
8 Hide shooting details

RemoteCapture DC
G (AL T

=
[

Lo N Ot

Release

You can add
comments to images
by placing a check

] Add camments shown below

captured.

Release Button
Releases the

mark here and
typing text in the
boxes below.

shutter.

Slide this to zoom
the camera in or out.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to 4{ Field angle/flash | Shooting settings
dlsplay the image Focusing Point: Flash:

appearing in the :] off E

Start/Stop Viewfinder
Button

: Starts or stops the

) viewfinder display.

Refresh Button

's viewfi . Macro: FlashQuality:
camera’s viewfinder ;:fm : ashQuality | Resets the exposure,
AF-assist light: focus and white
C— balance.
AF operation:
AF unlock 4

Set the camera shooting settings here.

Iﬁl The settings available vary between camera models.
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 select a series of images in the ImageBrowser’s Browser Area.

Click the [Edit] menu and select 06 Photosttch
[PhotoStitch].

7. Click [Arrange] 1o select e merge directian when ail e Images are loaded.
2. Drag images into the correct position for merging

3. Click [2. Merge].

Instructions

STA_0578JPG STB0579.PG STC_0580.JPG STD_0581.JPG

No-otimages | [ iomxrestuecao 7

3 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

e Some camera models may not support Stitch Assist mode.

e See the Camera User Guide for information about shooting in Stitch Assist mode.

e |mages shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

*Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

*The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

*You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 dickan image, then select [Process RAW Images by Digital Photo Professional] in
the [File] menu.

2 select aRAW image in Digital Photo Professional’s Main Window.

Selects folders —
containing
images.
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) Adjust the image brightness and white balance in the tool palette.

The modified contents (the information for image processing requirements) are saved
along with the image as a “recipe”.
The items available to be modified differ depending on the camera model

You can adjust all three RGB

channel levels together or

separately with the Tone Curve. Reduces noise that occurs
when shooting night time
scenery, or when shooting
at a high ISO speed.

B8 Digital Photo Professional - [ Macintosh HD/ Users/ XXX/Pictures/IMG_0012.CR2 |

Adjusts the brightness,
white balance and picture
style.

FcureSofe

Tool Palette

Adjusts the contrast, color
tone, colorsaturation and
sharpness.

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 In the [File] menu, select [Convert and save], set the file type and destination and
then click [Savel].

Renames the file. Convert and save

|— Save As: | IMG_0013 )
Selects the file ———— where: [ [ pictures )
destination.

File format

Kind of file Exif-JPEG -
| magequality T L, @ 10

Selects the file type.

Output setting

Ouputresalution 350 dpi @ Embed ICC profile
Resize setting
Insertacheck mark ——— resize
Width Height Unit
here to change the T - -
file size. (4416 pixel ) (3312 pixel )

W Lock aspect ratio
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

|— Inserts text.

XXXXXXXXHXXXXXXXXXX

635 | mm 76.73 | mm
Width: Height:
XXXXXXXX | 19720 mm 131,47 mm

Image layout:

@EM

Sets the image size and
image layout, and
shooting information.

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

|— Inserts text.

«t_ Settings |

2 1-40)

=T Sets the number and order
of images laid out on one
sheet.

e
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Enjoy Customizing Your Camera with the My
Camera Settings

My Camera functions can are only available with camera models listed as
compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you

install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 f CameraWindow appears, click [Operate Images on Camera] followed by EJ in
the View Window to close CameraWindow.

CameraWindow

EEERe

| Canon Unumies
CameraWindow D

Thumbnail Window View Window
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3 Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.

The My Camera window will display.

4 sclectthe type of setting in the Type list box that you wish to save to the camera.

5 sclectthe settings to add and replace.

Settings to add: select from the [Computer] list.
Settings to replace: Select from the [Camera] list.

6 Click the [ | button.
If a setting for this category has previously been saved to the camera, press [OK] and it will
be overwritten.

7 Click the [Save to Camera] button.
Click [OK] to conclude the process of saving the My Camera settings to the camera.

Save to Camera “ I— Save to Computer
MpCarjera DC

Type

Computer Camera

m -> 3321
321
Displays the settings saved ———ion ¢ )

BAR21

to the computer. sasEmALLYL

Play ) € Delete...
CHIMPAN21 e
ETHDANCE21 re
ETHTECHN21 M
Add Send to Trash _

Play Canon

[Send to Trash] Button
Deletes settings from the
computer.

Save To:Macintosh HD/Users/XXXXX /Library/Preferences /ImageBrowserUserData/

Save to Camera Exit

8 Changing the My Camera settings with the camera.
See the Camera User Guide.
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Adding Original Start-Up Images or Sounds

You can add original start-up images or sounds created with image editing and other software
to the My Camera Window. Sound files are saved as WAVE-type files.

1 Doublelick the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.
The My Camera window will display.

2 Select the [Start-up Image] in Type.

For sound files, select either [Start-up Sound], [Operation Sound], [Selftimer Sound] or
[Shutter Sound].

3  Click [Add].

CHIMPAN21 5101 JPG
ETHDANCE21_SI01.JPG

e Cang
E 57,
[Add] Button Send to Trash ) k
Addsimages and sound v

files for use as settings
files in the list.

Save to Camera ( Exit )

4 sclect the file you created and click [Open].
This concludes the process for adding new data.

You can add the settings files you just added to the computer to the camera using the
same procedures as in Adding My Camera Settings to the Camera (p. 68).

Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images

Image Type : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Resolution (WxH) 1320 x 240 or 512 x 288*
* Varies with camera model
e Start-Up Sounds
Type : WAV (Monaural)
Bit Rate / Frequency : 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the
following chart.

Type Duration in Seconds
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

1 Click the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

The uninstall utility will start and remove
ZoomBrowser EX.

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.

qSOIU!)DW/SMOPU!M
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Memory Card Folder Structure

The images on a memory card are placed in subfolders of the [DCIM] folder labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 999.

— IMG_xxxx.JPG (JPEG images)
B T — _MG_xxxx.JPG (JPEG images recorded in the
DCIM Adobe RGB color space)
XXXCANON L |MG_xxxx.CR2 (RAW images)
—— _MG_xxxx.CR2 (RAW images recorded in the
Adobe RGB color space)
— STx_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.MOV, MVI_xxxx.THM* (Movies)
— MVI_xxxx.AVI, MVI_xxxx.THM* (Movies)
—— SND_xxxx.WAYV (Sound annotation)
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The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC
L B _— B SDR_xxxx.WAYV (Files recorded with Sound Recorder)
SNDR xxXCANON

¢ *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

e The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

¢ All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.

* Depending on the camera, some data types cannot be recorded.



Appendices

Troubleshooting

Please read this section if you encounter a problem using the software.

=
o
o
=
wv
S~
=
2
=,
s
=
o
w
=

Start by Checking This

Investigate the following points first if you encounter a problem.

@ Does your computer satisfy the requirements listed in the System
g Requirements section (p. 9)?

Is the camera correctly connected to the computer?

)

See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.

@ Are the camera and computer in the correct modes to transfer data?
Q

Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.

? Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery.
You are recommended to use an AC adapter (sold separately) to power
the camera when it is connected to a computer.
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Try the suggested solutions to the common problems listed below.

@ Add New Hardware Wizard displays when the camera is connected to
g the computer with an interface cable (Windows).

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

@ Cannot download images or shoot remotely. (For cameras connected to
g the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by
following the procedures below.

Solution:

Hold the MENU button on the camera down and press the Lya~ (Print/Share)
button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.

@ Camera not detected, Events dialog won't display or images will not
g download to the computer (when camera is connected to the computer
via an interface cable (Windows)).

The camera may have been recognized as another device under the

following circumstances (Windows only).

¢ The [Scanners and Cameras] icon cannot be found in the [Hardware and
Sound] within the [Control Panel] or the [Printers and Other Hardware]
window.

* Your camera model name, [Canon Camera] or a camera icon does not display
when [Scanners and Cameras] icon is clicked.

Solution:
Delete the device with the following procedures.

You must be authorized as a Computer System Administrator to delete
devices.

1. Display the [Device Manager] dialog.
Windows Vista: Click the [Start] menu, [Control Panel], [System and
Maintenance], [System], and Task list [Device Manager].
Windows XP: Click the [Start] menu, [Control Panel], [Performance and
Maintenance], [System], [Hardware] tab, and the [Device Manager] button.
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2. Click the [#] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories
if it is being recognized as an “other” device.

5, Device Manager (B[] 5, Device Manager (B[]
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There are other potential reasons for the problem if the “Other
devices”, "Portable Devices” or “Imaging devices” categories do not
appear or your camera model name or [Canon Camera] does not appear.
Proceed to Step 5, and temporarily quit the procedures.

3. Select your camera model name or [Canon Camera], right-click and select
[Delete].

4. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

5. Close [Device Manager] or [System Properties].
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Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel].
2. Display the [Hardware acceleration] setting window.

Windows Vista: Click [Appearance and Personalization], followed by [Adjust
screen Resolution], [Advanced Settings] button and [Troubleshoot] tab.
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Windows XP: Click the [Appearance and Theme] icon, followed by the
[Display] icon, [Settings] tab, [Advanced] button and [Troubleshoot] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

An error message "Insufficient free memory" displays when

using PhotoStitch

Please try one of the following methods.

¢ Close all other applications other than PhotoStitch.
® Reduce the size or number of images to combine.
¢ In the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce the size.
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Downloading Images without Installing the
Software

You can download images by simply connecting the camera to a computer, without installing
the software bundled on the Canon Digital Camera Solution Disk.
However, please note that there are several limitations.
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Iﬁl If you use the bundled software, the following limitations do not apply.

e [t may take a few minutes, after connecting to the camera, until you can download images.

¢ The camera information (firmware version, etc.) may not display correctly. In this case, use the
software from the Canon Digital Camera Solution Disk.

¢ Sound files attached to still images as sound memos and sound files recorded with the Sound
Recorder function may not download depending on file size and software used.

*RAW images or JPEG images recorded at the same time as RAW images may not be
downloadable with some software programs or operating systems.

* Movies may not download correctly if the file size or software program is incompatible.

eImages shot in the vertical orientation may be downloaded in the horizontal position.

¢ The protection setting for images protected in the camera may be lost when transferred to
the computer.

¢ In addition, there may be problems with downloading images or image information correctly
depending upon the version of the operating system in use, the file size or the software in
use.
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